
Bacterial growth 
 
Subject Area(s)  Biology, measurement 
Associated Unit  None 

Associated Lesson None 
Lesson Title   Bacteria are everywhere! 
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Grade Level   7 (5-7) 
Lesson Dependency None 
Time Required  Three one hour sessi ons, over the length of one week 

Group size   4-5 
Expendable cost/group US$5  
Summary  

In this exercise, students will learn that bacteria can be found everywhere, including on 
the surface of our own hands. Students will study three different conditions and 
compare the growth of bacteria from these surfaces: (1) unwashed hand, (2) hand 
washed with soap and water, and (3) hand sanitized with antibacterial hand gel. The 
students will take swabs of their hands in these three different conditions and streak the 
swabs on Petri dishes containing agar gel which supports bacterial growth. After 
creating these three samples, over the period of one week the Petri dishes will show 
growth of several different kinds of bacteria, and the students will quantitatively compare 
the amount of bacteria growing from each test condition. Quantitative analysis of these 
samples will be done by taking photos of the Petri dishes at different time points and 
analyzing the images through imaging software. In addition to monitoring the quantity of 
bacteria from differ conditions, they will also be able to record the growth of bacteria 
over time, which is an excellent tool to study binary fission and the reproduction of 
unicellular organisms.  
 

Figure 1 
ADA Description: Photo of a Petri dish containing 

multi-colored bacterial colonies grown from a 
student’s hand.  

Caption: These colorful bacterial colonies were 
grown from bacteria present on our hands!  
Image file: Figure 1_bacterial colonies.jpg 

Source/Rights: Copyright © 2012 Jasmin Hume 



Engineering Connection 

Students will learn to design an experiment to test the effect of environmental conditions 
on the growth of living organisms. This experiment teaches students that bacteria, and 
other microorganisms, can be, and are found everywhere.  
Not only do students get to visualize the growth of bacteria over a few days time, but 
they will also quantize the growth by analyzing images of the Petri dishes. This type of 
lesson is eye-opening for students, as a unit covering microorganisms is often quite 
difficult to grasp due to the fact that bacteria are not visible to the naked eye. An 
engineering connection is also made in that students will learn that bacteria can both be 
harmful, as well as helpful to our bodies. There are also bacteria that are being 
genetically engineered to produce compounds such as therapeutic proteins and other 
synthetic molecules which are being developed for use as medicines and other 
beneficial substances. The engineering of biological organisms is something that 
students will be introduced to in this activity.  

Engineering Category  #1 
Keywords bacterial, image processing, microorganism, biology, growth 
 

Educational Standards 

• New York State standards for “Living Environment”: 
o Standard 1 (scientific inquiry), key ideas 2 and 3 
o Standard 4 (understand and apply scientific concepts, principles, and 

theories pertaining to the physical setting and living environment), key 
ideas 1 and 4 

• New York State standards for “Intermediate Science”: 
o Standard 1 (analysis, inquiry, and design), key ideas 2 and 3 
o Standard 4 (the living environment), key idea 4 

 
Pre-Requisite Knowledge  
None. 
 

Learning Objectives 
After this lesson, students should be able to: Students will also understand the 
overwhelming amount of bacteria surrounding our daily lives and their positive and 
negative roles in our lives – including medicinal uses like antibiotics and gram-staining. 
 
  



Materials list 

Per group:  
• 3 Petri dishes (10 cm diameter) 
• 75 ml tryptic soy agar (TSA)  

o Preparation instructions: add 10 g TSA to 250 ml water in a 
microwaveable container. Microwave the solution for about 3 minutes 
(until boiling). Pour the hot solution into the Petri dishes, so that you just 
cover the bottom completely. Let Petri dishes stand for 20 minutes while 
the agar solidifies. 250 ml TSA solution will make 30 Petri dishes; adjust 
quantities appropriately depending on how many dishes you want to 
prepare.  

• 3 Q-tips (1 per sample) 
• Camera and computer 
• ImageJ software (free download at http://rsbweb.nih.gov/ij/download.html)  

 
Introduction / Motivation 

The growth of bacteria over time provides an excellent model for the study of 
prokaryotes reproduction of through binary fission. Students will be able to determine 
what factors influence bacterial growth, and quantify the effects of these various factors. 
The common perception among middle school students is that bacteria are malevolent, 
whereas in reality there are a plethora of different bacteria that can be beneficial to us. 
Not only do these organisms have effects on the exterior and interior of our bodies, but 
bacteria such as E. Coli are also used by biochemists and protein engineers to produce 
important proteins for therapeutic purposes through biosynthesis.  

Lesson Background & Concepts for Teachers 

Bacteria are found all around us, and can be harmful or beneficial to our health. 
This lesson visually shows students that bacteria are found even in large amounts on 
our hands. It also teaches them that there are things that we do to prevent the growth of 
bacteria or kill them, such as washing our hands and applying antibacterial hand 
sanitizer.  
 The use of image processing software in this experiment teaches students not 
only that we can qualitatively study bacterial growth, but we can actually obtain 
measurements on how much bacteria is growing, and if studied over time, the speed of 
this growth.  
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Vocabulary / Definitions 
Word Definition 

Bacteria A unicellular microorganism with no nucleus 
Colony A visible cluster of bacteria  
Fission One cell divides into two, bacteria reproduce this way 
Aerobic respiration Respiration that requires oxygen 
Anaerobic respiration Respiration that does not require oxygen 
Eukaryotic Cell that has a nucleus 
Prokaryotic Cell that lacks a nucleus 

 
  

Figure 2 
ADA Description: Photo of students using a Q-tip to streak bacteria 

from their hands onto Petri dishes containing agar.  
Caption: Students take turns streaking plates from bacterial that is on 

their hands.  
Image file: Figure 2_streaking plates.jpg 

Source/Rights: Copyright © 2012 Jasmin Hume 



Procedure 
Procedure for making TSA plates: see “preparation instructions” in Materials List 
section of this document. 

Samples of bacteria on the surface of student’s hands will be taken and the bacterial will 
be grown over time. Samples will be taken from one student’s hand under three 
different conditions: 

1. Unwashed hand 
2. Hand washed with soap and water 
3. Hand sanitized with antibacterial hand gel 

Procedure for streaking plates:  
1. Chose one student from the group to obtain samples from (it is important 

to have all samples come from the same person to reduce experimental 
error). 

2. Label 3 Petri dishes by writing the group number, sample name 
(unwashed, washed, or sanitized), and class on the lid with a Sharpie.  

3. Start with the “unwashed” hand. Gently rub a Q-tip on the surface of the 
student’s palm. Open the Petri dish (labeled “unwashed”) containing agar 
and rub the Q-tip back and forth on the agar. Students must be careful not 
to apply too much pressure when doing this, otherwise the agar will tear.  

4. Close the Petri dish. 
5. Student will wash one hand with soap and water (may need assistance 

from a teacher or group member) and repeat Steps 3 and 4 for this hand; 
being careful to streak the plate labeled “washed” this time.  

6. Hand sanitizer will be applied to the student’s other hand (may need 
assistance from a teacher or group member). Allow it to air dry until all gel 
has evaporated. Repeat Steps 3 and 4, except being careful to streak the 
plate labeled “sanitized” this time. 



Procedure for data acquisition:  
1. Take a photo of each plate approximately 4 days after streaking.  
2. Open Image J software.  
3. Select File, then Open from the drop down menu.  
4. Select the image file you would like to analyze.  
5. Trace a line over your scale bar. Select Analyze then Set scale. Fill in the 

“Known distance” box for the length of your scale bar, and set the “Units”.  
6. Click Image > Adjust > Threshold. For the Threshold Color, select B&W. 

Adjust the Hue, Saturation, and Brightness levels unti l you obtain your 
bacterial colonies in black and the background agar in white.  

7. From the toolbar, select the circle image. Draw a circle around the edge of 
the Petri dish to define where the software will measure from.  

8. Next, from the Analyze menu, select Analyze Particles. Set an upper limit 
to the size (generally bacterial colonies would not by larger than 4 cm2

9. The Summary window will open and will provide data on the area of the 
Petri dish that is covered in bacterial colonies. This data is found under the 
column “Total Area”, and is given in square units of what you entered in 
step 5. The Summary window also displays the “Area fraction”. Students 
may record the area fraction (given as a % of the total area measured) 
and use this as their data for the amount of the Petri dish covered by 
bacteria.  

). 
Circularity should be 0-1, and select Nothing from the Show drop down 
menu. Select Summarize from the checklist. Click Ok.  

10. If you chose, you can save the adjusted photo by File > Save As.  
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Figure 3 
ADA Description: Black and white threshold adjusted photo of Petri 
dish with bacterial colonies grown from an unwashed hand. This is 

done in ImageJ software and is necessary for data acquisition.  
Caption: Black and white photo of a dish with bacterial colony 
growth. ImageJ analyzes the size of the circular black particles 
(colonies) and expresses it as a fraction of the area analyzed. 

Image file: Figure 3_black and white dish.jpg 
Source/Rights: Copyright © 2012 Jasmin Hume 
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Attachments 

• Pre-evaluation survey 
• Post-evaluation survey 
• Worksheet 
• Bacterial colonies photo (Figure 1) 
• Streaking plates photo (Figure 2) 
• Black and white photo of bacterial plate (Figure 3) 
• Group work photo (Figure 4) 

 
Safety issues 
As this activity involves growing bacteria from students’ hands, there are several safety 
precautions that should be taken. As soon as the plates have been streaked, the lid 
should be replaced and two pieces of tape can be applied to keep them shut (any 
closure should not be air-tight, however). These plates should be kept away from 

Figure 4 
ADA Description: Students working together as a group to streak 

Petri dishes with bacteria from their own hands and answering 
questions pertaining to the experiment.  

Caption: Figure 4.  
Image file: Figure 4_group work.jpg 

Source/Rights: Copyright © 2012 Jasmin Hume 



students until the time of data analysis. No one, at any time, should touch the agar or 
the bacteria. When taking pictures, the lid should be opened briefly and replaced 
immediately after data collection is complete.  
When the activity is complete and pictures have been taken of all samples, the Petri 
dishes should be discarded immediately.   
 
Troubleshooting tips 
For optimal growth of the bacteria, make sure that they are grown between room 
temperature (22 ⁰C/72 ⁰F) and body temperature (37 ⁰C/99 ⁰F) and in a well ventilated 
area.  
Assessment 
Pre-Activity Assessment 

• See “Pre-evaluation survey” attachment. 

Activity Embedded Assessment 
• See “Worksheet” attachment. 

Post-Activity Assessment 
• See “Post-evaluation survey” attachment. 

 
Activity Scaling 

• For lower grades: For lower grades, the analysis of the images can be omitted 
and bacterial growth can simply be visualized by eye. A relative quantization of 
the amount of bacterial growth in the Petri dishes by comparing the three 
samples against one another.  

• For upper grades: For upper grades, images of the samples can be taken more 
frequently and quantified and plotted. This plot should show and exponential 
growth of bacteria over time. The data can be fitted to exponential curves 
mathematically and regression can be performed to determine how closely the 
experimental data matches the theoretical predictions.  

Additional Multimedia Support 
None. 
 

References 
None. 
 
Redirect URL 
http://gk12.poly.edu/amps/ 
 
 



Owners 
Jasmin Hume 
 
Contributors 
Jasmin Hume 
 
Supporting Program 
This activity was developed under the Applying Mechatronics to Promote Science 
(AMPS) program funded by a National Science Foundation GK-12 Fellows grant no. 
0741714. Additional support under the Central Brooklyn STEM Initiative (CBSI), funded 
by six philanthropic organizations is also acknowledged. 
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